
Konwersja dwóch AVI do DVD oraz Autoring w DVDLab Pro

KaĪdy, kto nabył nagrywarkĊ DVD chciałby zarchiwizować swoje filmy na noĞniku jakim jest płyta DVD.
Mamy w swoich zbiorach pliki DivX, które nadają siĊ do konwersji na DVD bez zbytniej utraty jakoĞci. Na
monitorach telewizyjnych nie powinno być widać róĪnicy jeĞli wykonamy to z głową i pewnymi zasadami.
MoĪna równieĪ wg tego opisu zamieĞcić materiał z kilku zrobionych przez nas SVCD lub VCD. Cały projekt
naleĪy sobie dokładnie rozplanować, iloĞć materiału nie moĪe przecieĪ rozmiarem przekraczać moĪliwoĞci
płyty. Zakładamy w naszej instrukcji, Īe chcemy umieĞcić na płycie 2 filmy z napisami oraz fotosy lub
ulubione zdjĊcia tematycznie związane z naszymi filmami. 

Nasza instrukcja bĊdzie opierała siĊ o znane i wspierane przez nasz serwis programy: Do
konwersji AVI na MPEG 2 wykorzystamy program DVD2SVCD. Do utworzenia płyty DVD -komercyjny
program DVD-Lab Pro - podajemy oficjalną wersje Version 1.0 build 041019 [trial - na okreĞlony czas
uĪytkowania]. Opcjonalnie program do konwersji napisów do formatu *srt np. SubRip (patrz dział
download) 

Jak przygotować materiał 

Pierwszym krokiem jest instalacja programów i odpowiednie rozplanowanie miejsca na dysku. Potrzebne
bĊdzie go sporo, gdyĪ wykonamy konwersje dwóch plików. Przy wyborze materiału do konwersji naleĪy
kierować siĊ formatem tegoĪ materiału. Nie moĪe to być zawartoĞć mieszana, poniewaĪ istnieje moĪliwoĞć
niekompatybilnoĞci danej płyty z odtwarzaczem. Tak wiĊc do projektu wybieramy pliki w PAL lub NTSC.
Pliki jeĞli są podzielone najlepiej sobie połączyć, łatwiej jest wówczas wyliczyć odpowiedni rozmiar do płyty
DVD. Konwersja w programie DVD2SVCD. Wskazówką bĊdzie ustawienie odpowiedniego rozmiaru
koĔcowego plików. Dlaczego DVD2SVCD? PoniewaĪ wydaje siĊ łatwy ze wzglĊdu na pełną automatyzacje i
wbudowany kalkulator bitrate. Dobór ĞcieĪki audio i jego bitrate jest równieĪ indywidualną sprawą, jeĞli
posiadane AVI ma dĨwiĊk wielokanałowy moĪemy go zachować zaznaczając opcjĊ w zakładce audio [ Do 
not convert audio (use source audio)]. Warto, by uniknąć błĊdów zmienić na pasku AVI Audio
extraction na Internally. Nie uĪywamy w programie obniĪania czĊstotliwoĞci próbkowania. DVDLab
przyjmuje audio standard DVD, czyli z czĊstotliwoĞcią 48 000Hz. Nie naleĪy równieĪ tworzyć w programie
napisów włączanych/wyłączanych tzw. selectable. JeĞli ktoĞ gustuje w takich lub bĊdzie łatwiej moĪna
wkleić napisy na stałe w obraz. Selectable napisy pokaĪemy jak wykonać w DVDLab Pro. W koĔcowym
efekcie bĊdziemy potrzebowali plików nie muxowanych, czyli video i audio osobno. Nie ma potrzeby
zaznaczać opcji tworzenia obrazu płyty [zaznaczamy No Image]. Wybierając domyĞlny folder zrzutu
[Default output folder], najlepiej jest wybrać równieĪ drugą opcjĊ z zakładki czyli strukturĊ folderów [ Set 
folder structure] i wg gustu nazwać kolejne foldery [dla pewnoĞci nie uĪywamy polskich znaków
diaktrycznych] Oto przykład: 

 

Sprawdzamy w folderze głównym czy faktycznie utworzyły siĊ pod-foldery jeĞli tak, oznacza to, Īe wszystko
jest gotowe do pracy. NajwaĪniejszym punktem konfiguracji programu jest ustawienie rozmiaru koĔcowego
pliku. Do tego celu otwieramy zakładkĊ Bitrate i wpisujemy rĊcznie wartoĞć jaką planujemy osiągnąć.
Zakładamy, Īe troszkĊ miejsca na płycie bĊdzie potrzebne na utworzenie menu, rezerwujemy ok 50 do 100
MB na nasze menu, w zaleĪnoĞci jak bardzo rozbudowane ono ma być. Tutaj naleĪy pamiĊtać, Īe struktura
płyty DVD róĪni siĊ znacząco od zapisu w systemie Windows. 1024mb=1GB gdzie na DVD bĊdzie to
zwiĊkszone o dodatkowe dane i zajmie ok. 1.11GB. PamiĊtajmy przy wyliczaniu by nie dzielić rozmiaru
podawanego przez DVD2SVCD na pół jeĞli chcemy zmieĞcić dwa filmy na 1DVDR. Zostaną doliczone
dodatkowe wartoĞci niezbĊdne do zapisu na płytĊ i powstały materiał przekroczy moĪliwoĞci płyty. Aby
podzielić nasze pliki równo na pół z zachowaniem miejsca na menu, naleĪy pamiĊtać jak obliczać zawartoĞć
wg posiadanej płyty. Do kaĪdego 1GB moĪe być doliczone ok. 110MB na dodatkowe dane. 

Czysta DVD-R 4,489MB 4,706,074,624 b 4.383GB

Czysta DVD+R 4,483MB 4,706,074,624 b 4.377GB
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MoĪna zarezerwować wiĊcej miejsca przy krótszym pliku filmowym, dłuĪszy - wykorzystać rozmiar
maksymalnie wyliczając róĪnice z powstałego pliku [ film1] a miejscem pozostałym na płycie DVD.
Najlepszym wyjĞciem jest wyliczenie procentowe w stosunku do obu plików filmowych. PamiĊtając,Īe do
naszego projektu potrzebne są dwa pliki nie muxowane moĪemy przypilnować program i zakoĔczyć jego
prace jeĞli tylko nasz enkoder [CCE] wykona swoje dzieło. Nic oczywiĞcie siĊ nie stanie jeĞli program
zmuxuje pliki, moĪemy ten zmuxowany plik wówczas Ğmiało usunąć [wskazane jest zaznaczenie opcji
Don't delete any files w zakładce MISC]. Do projektu zachowujemy pliki z rozszerzeniem *mpv, *mpa
lub *ac3. JeĞli mamy zamiar zamienić MP2 na AC3/2.0 najlepiej zachować plik *wav. PamiĊtajmy, Īe przy
standardzie NTSC zachowujemy plik Pulldown w nazwie. JeĞli komuĞ nie zaleĪy zbytnio na jakoĞci moĪna
w podobny sposób przygotować wiĊcej niĪ dwa pliki. To tyle na temat DVD2SVCD. 

ZawartoĞć z gotowych plików lub innych programów? 

Pliki z innych programów typu TMPGEnc z rozszerzeniem *m2v równieĪ nadają siĊ do autoringu w DVDLab,
Ğmiało moĪna wykorzystać instrukcjĊ w dalszej czĊĞci. Plikom otrzymanym z Canopusa naleĪy zmienić
rozszerzenie do *mpv i równieĪ bĊdzie je moĪna zaimportować w DVDLab. Aby instrukcja słuĪyła wszystkim
chĊtnym, którzy mają juĪ gotowe pliki mpeg [VCD, SVCD] zapisane na CDR, chcieliby przerzucić to na
DVD, podamy wskazówki. 

Przygotowanie gotowych VCD i SVCD 

Gotowe płyty najproĞciej jest rozpakować do struktury MPEG w Media Player Classic. Wkładamy płytĊ do
napĊdu z zakładki File wskazujemy Open CDRom, po uruchomieniu ponownie klikamy File i z menu
wybieramy Save As pojawi siĊ okno w którym wskazujemy miejsce zrzutu i zamieniamy nazwĊ pliku
AVSEQ01 na dowolną jakiej chcemy uĪyć dopisując odpowiednie rozszerzenie np. Film1.mpg. PamiĊtajmy
Īe materiał w postaci *mpg bĊdzie demuxowany automatycznie przez DVDLab, czyli oddzielane zostanie
audio od video. MoĪemy to równieĪ uczynić rĊcznie w innym programie [np. VCDEasy], jeĞli tylko tak nam
bĊdzie wygodniej. Plików zrzuconych z VCD czy SVCD moĪemy umieĞcić kilka na naszym nowym noĞniku,
tworząc do nich własne menu i dodatki. WaĪne by nie mieszać zawartoĞci z róĪnymi rozdzielczoĞciami
obrazu lub standardami. Do projetu wybieramy SVCD lub VCD w PAL lub NTSC. Jak rozpoznać dany format,
czy jest to mpeg1, czy teĪ mpeg2? Najlepiej zainstalować sobie program GSpot, dziĊki niemu dowiemy siĊ
jaki kodek, format i jaką rozdzielczoĞć ma nasz plik. 

DVD-Lab PRO - Autoring 

Otwieramy program, który na wstĊpie zada nam pytanie o standard i formĊ jaką chcemy utworzyć na
naszym DVD. 1. Proste menu z filmem (ami) 2. Zaawansowane menu 3. Sam film 4. Otwiera projekt
zapisany wczeĞniej na dysku (warto zapamiĊtać kiedy rozkładamy naszą pracĊ na raty) UWAGA: Warto by
nie stracić naszej pracy zapisywać ją czĊsto [Ikona dyskietki > Save]. Wybieramy oczywiĞcie
odpowiedni dla nas projekt, który bĊdzie zgodny z naszym planem. Dla wczytujących pliki typu (S)VCD,
konieczne bĊdzie wybranie zaawansowanego menu. W naszej instrukcji równieĪ pokaĪemy to na
przykładzie Advanced Project. 
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Po wybraniu odpowiedniego dla naszego pomysłu projektu, zapoznamy siĊ z oznaczeniami w nim. Klikając
dwa razy na folder z projektu bĊdziemy uaktywniać na pierwszy plan dane okno, naleĪy je
zmaksymalizować dla wygody. W ten sposób poruszamy siĊ miĊdzy folderami projektu lub wybierając
zakładkĊ folderu, jaka powstanie w centrum naszego okna. Zakładki równieĪ noszą nazwy kolejno jak w
czĊĞci Project. 

Connections - pokazuje i umoĪliwia graficznie połączenie plików zgodnie z naszymi załoĪeniami i
standardem płyty DVD. VMG Menu 1 - menu tytułowe, czyli to na które bĊdzie siĊ przełączał odtwarzacz,
gdy z pilota wybierzemy przycisk TITLE. Movie 1 - okno konfiguracji pierwszego filmu. Menu 1 - VTS
ROOT czyli menu główne, tutaj konfiguruje siĊ połączenia i odnoĞniki do poszczególnych plików,
dodatkowych menu itp. RównieĪ ROOT wybieramy z pilota naszego odtwarzacza [root lub menu]. W
górnej czĊĞci projektu widzimy ikony, dziĊki którym moĪna dodawać nowe elementy do naszego projektu
[Quick Tools]. JeĞli mamy zamiar skomponować płytĊ z dwoma lub wiĊcej filmami klikamy na pierwszą
ikonĊ oznaczającą Add Movie [dodaj film, dostĊpne równieĪ w menu prawego przycisku myszy jak na
zrzucie]. W folderze Movies pojawi siĊ Movie 2, graficznie dodane zostanie w connections. 

 

NaleĪy sobie teraz uzmysłowić i przemyĞleć projekt uruchamiania kolejoĞci naszych plików. Mamy spore
moĪliwoĞci wzbogacić nie tylko graficznie ale i pod wzglĊdem obsługi nasze menu. Dla początkujących
radzĊ nie uwikłać siĊ w zaawansowane prace i przetestować proste i łatwe menu z filmem (-ami). Kolejnym
oknem jakie poznamy jest ASSECTS, tutaj bĊdziemy wczytywali kolejno przygotowane przez nas wczeĞniej
pliki multimedialne. WspomnieliĞmy o graficznej szacie menu, istnieje moĪliwoĞć zaimportowania własnych
materiałów zdjĊciowych, które moĪna wykorzystać umieszczając w menu. Mogą to być fotosy, zdjĊcia
aktorów czy teĪ inne pomysły. Mogą one słuĪyć jako przyciski lub teĪ jako tło. Wszystko w rĊkach twórców i
ich pomysłów. 

Rozpoczynamy wczytywanie naszych plików, które wczeĞniej przygotowaliĞmy. Dobrze, aby zachować
porządek, trzymać je posegregowane i odpowiednio nazwane. Zmniejszy siĊ wówczas prawdopodobieĔstwo
pomyłki. Importujemy nasze przygotowane pliki video i audio za pomocą ikony otwartego folderu do okna
Assets. Dla naszych audio mamy pod rĊką dodatkowe narzĊdzia do konwersji dĨwiĊku. DziĊki temu
moĪemy zmienić bitrate, nawet format *mp2 lub *wav/pcm na AC3 [oczywiĞcie dwukanałowe]. Dla AC3
wymagany jest jednak plugin TMPGEnc Sound Plugin AC3, dokładnie ten sam, którego uĪywa program
TMPGEnc. JeĞli ktoĞ posiada tą wtyczkĊ, moĪe swobodnie korzystać z tego narzĊdzia. Na zrzucie przykład
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jak wyglądają zaimportowane pliki w róĪnych formatach: 

Podczas wczytywania audio moĪe zdarzyć siĊ, Īe wyskoczy komunikat. BĊdzie to informacja, iĪ nasz dĨwiĊk
jest w niĪszej czĊstotliwoĞci próbkowania od zakładanej przez standard [48000 Hz]. W takim przypadku
moĪemy zgodzić siĊ aby program wykonał resampling lub rĊcznie przeprowadzić to w dowolnym edytorze
audio. Aby dodać nasze pliki do projektu naleĪy je przeciągnąć do okien Movie pamiĊtając by nie pomylić
audio z drugiego filmu, dlatego najpewniej jest importować i z miejsca dodawać. Kto odpowiednio sobie
pozmieniał nazwy wczeĞniej nie bĊdzie miał tutaj problemów. PamiĊtajmy, Īe mając standard NTSC naleĪy
importować plik po Pulldown, jeĞli wybierzemy bez, program sam zaproponuje jego wykonanie. Polega to
na zamianie iloĞci odtwarzanych klatek na sekundĊ. Standard NTSC na DVD wymaga 29.97 kl/s, dlatego
pamiĊtajmy, które pliki w tym przypadku usuwamy po konwersji w DVD2SVCD.

Nasze filmy są juĪ dodane teraz zajmiemy siĊ stworzeniem menu do nich. Na początek pokaĪemy jak zrobić
bardzo proste menu, z którym kaĪdy sobie doskonale poradzi.

Plan: W oknie tytułowym [title] utworzymy plansze, która bĊdzie witała oglądającego nasz
materiał. BĊdzie to pierwsza plansza jaka siĊ ukaĪe na ekranie TV po uruchomieniu płyty.

W celu uruchomienia edycji planszy klikamy 2x w okno graficzne VMG Title [VMG menu 1]. Otworzy siĊ
okno gdzie mamy moĪliwoĞć edycji. JeĞli mamy zamiar umieĞcić w tym oknie gotową planszĊ z tłem [np.
zdjĊcie, fotos], importujemy je przed tym faktem do Assets > Background i przeciągamy do naszego
menu tak, jak to robiliĞmy z plikami audio i video. PamiĊtajmy o wyskalowaniu odpowiednio wczeĞniej tego
zdjĊcia. Nasz projekt tego nie zakłada, wiĊc tworzymy tylko napis. W tym celu w otwartym oknie Menu 1
wybieramy z lewej strony narzĊdzie do pisania tekstu Aa i tworzymy nasz napis klikając na czarne pole.
MoĪemy wybrać czcionkĊ i rozmiar, napis nastĊpnie odpowiednio ustawiamy na ekranie łapiąc i
przytrzymując myszką zgodnie z wyskalowanym polem, staramy siĊ go nie przekroczyć. MoĪna ubarwić
swoją planszĊ podają autora tej płyty. Napisy są oczywiĞcie w tym wypadku w waszych rĊkach, czyli
pomysłem własnym autora. Napis ten musimy podlinkować wskazując na Menu Root [Menu >
Properties>Link lub prawym przyciskiem myszy na napisie wskazać odnoĞnik do Menu Root]
Ostatnią czynnoĞcią jaką wykonamy w Menu 1 to konfiguracja czasu po jakim przełączy siĊ nasza plansza
do nastĊpnej wg zakładanego projektu [czyli menu root]. W tym celu pokazaliĞmy z prawej strony zrzutu
przykład. Wybieramy w Menu > Properties opcjĊ PBC i w polu Duration wpisujemy czas w sekundach po
upłyniĊciu jakiego, bĊdzie siĊ przełączała plansza tytułowa do nastĊpnej. 
Kilka słów o Menu Playback. Jest to podrĊczne menu do narzĊdzi jakie uĪywamy podczas tworzenia
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projektu. Mamy w nim do dyspozycji kilka ciekawych opcji do cieni i kolorów naszych napisów, uĪycia
tekstur [nakładając na obiekty], podglądu naszych połączeĔ, ustawienia koloru dla podĞwietlenia
aktywnego obiektu, czy uzyskanie informacji o obiektach.

Nasza pierwsza plansza, czyli VMG Menu 1 jest juĪ gotowe, projektujemy planszĊ drugą czyli Menu 1 
ROOT. BĊdzie to nasze docelowe menu, w którym bĊdziemy decydowali o wyborze odtwarzanego pliku. W
connections dodamy tym razem tło, w tym celu w Assects wskazujemy zakładkĊ Background i
impotrujemy wczeĞniej przygotowane zdjĊcie [*jpg, *bmp] w formacie 720x576 pikseli jeĞli projekt zgodny
jest z PAL. Inne formaty mogą zostać rozciągniĊte lub nie wypełnić w pełni całego ekranu w zaleĪnoĞci od
ustawieĔ tła. Gdy zaimportujemy zdjĊcie program zaproponuje konwersjĊ do własnego formatu *bin, my
oczywiĞcie potwierdzamy. Dodane do background zdjĊcie przeciągamy do okna naszego menu. Klikamy
teraz dwa razy na ROOT by wejĞć w edycjĊ naszego drugiego menu. Ponownie musimy rozplanować
plansze wg zawartoĞci jaką chcemy umieĞcić na płycie. Przykład nasz podaje menu do dwóch filmów, lecz
uĪytkownicy którzy importowali pliki z VCD czy teĪ SVCD bĊdą mogli tych plików filmowych mieć wiĊcej.
Trzeba sobie teraz odpowiednio naszą plansze wg tego zaprojektować.
PokaĪemy przykład jak zrobić odnoĞniki do filmów na dwa sposoby. Pierwszy bĊdzie to zwykły napis
[tworzymy identycznie jak w przypadku powyĪej z zachowaniem odpowiednich rozmiarów napisów], drugi
to import gotowego przycisku. Oba przypadki słuĪyć bĊdą jako nasze aktywne przyciski w wyborze drogi do
danego filmu.
MoĪemy jak na przykładzie utworzyć dwa napisy informujące o ich tytule. BĊdą tworzyły tylko tło, gdyĪ nie
bĊdziemy ich aktywować jako przyciski. Zrobimy to osobno tworząc napisy START. Pierwszy przykład
pokazuje napis utworzony na białym tle które równieĪ moĪna sobie wygenerować za pomocą narzĊdzia
Rectangle [ikony z lewej strony okna]. Na tle tworzymy właĞnie napis lub omijamy opcjĊ tła pod niego.
Mamy róĪne moĪliwoĞci ustawieĔ kolorów i rzutów tła do niego by ładnie skomponować taki napis. Napis
ten bĊdzie naszym aktywnym przyciskiem, musimy teraz z prawej strony w oknie Properties uaktywnić
Link i wskazać jak na zrzucie adres do pierwszego rozdziału filmu Movie 1. Po wskazaniu adresu do pliku
powinien siĊ pojawić podpis do aktywnego linka w naszym menu.
Drugi film podajemy na przykładzie wstawienia obiektu z zakładki Objects> zakładka Combo-Buttons w
oknie Assets. Wybieramy jeden z dostĊpnych obiektów i przeciągamy do okna. Tutaj znów mamy dwie
moĪliwoĞci uaktywnienia przycisku jako link. Napis na obiekcie [który edytujemy klikając w niego dwa
razy], moĪe być tym obiektem jak w pierwszym przypadku lub stanowić go sam wybrany przez nas obiekt.
Trzeba wskazać interesujący nas obiekt i przejĞć do podlinkowania jak to było z Movie 1. Wskazujemy 
Chapter 1 w Movie 2 i nasze filmy powinny juĪ prawidłowo siĊ uruchamiać, kiedy to bĊdziemy w tej
planszy podczas odtwarzania. JeĞli posiadamy wiĊcej plików filmowych do kaĪdego tworzymy oddzielny
obiekt/napis.

Przechodzimy do Connections i oglądamy jak wyglądają graficznie nasze połączenia. PowinniĞmy ujrzeć
czerwone linie zaczynające siĊ w ROOT oznaczające odniesienie siĊ do kolejnych filmów czyli okien Movie.
Oznaczają one linki z odnoĞników jakie utworzyliĞmy w oknie naszego menu Root. Fioletowa linia oznacza
czasowe przełączenie siĊ z pierwszego menu do drugiego. Pierwsze dwa linki z First Play i Title Button
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jeĞli nie utworzyły siĊ same musimy podlinkować rĊcznie. W tym celu wybieramy narzĊdzie Draw Links [z
lewej strony ikona "+"] i przeciągamy kursor miĊdzy oknami rysując linie. JeĪeli chcemy by po zakoĔczeniu
odtwarzania danego filmu powrócić bezpoĞrednio do naszego menu rysujemy równieĪ odpowiednie linki z
okna Movie do Root. Gdy to pominiemy płyta zacznie odtwarzać siĊ od początku. Szarym kolorem
zaznaczone jest oblinkowanie Menu Root, jest to tzw. LOOP. Oznacza to ciągłe odtwarzanie tegoĪ menu
dopóki z pilota nie wybierzemy danego obiektu i nie uaktywnimy go. Tworzy siĊ to rysując link do tego
samego okna, przeciągamy kursor od punktu 5 do Ğrodka okna Root. PominiĊcie tego bĊdzie skutkowało
uruchamianiem siĊ automatycznie pierwszego filmu czyli Movie 1. MoĪna równieĪ ustawić automatyczne
uruchamianie wg opisu przy tworzeniu planszy Title. Wskazujemy, który przycisk ma uruchamiać jako
pierwszy dany plik filmowy i wpisujemy wartoĞć w sekundach w polu PBC > Duration. To juĪ są opcje do
wyboru przez autora projektu.

W tym miejscu praktycznie nasze dzieło zostało ukoĔczone i moĪemy zapisać tworząc koĔcową strukturĊ
gotową do nagrania na płytĊ. [Opcja dla osób, które wkleiły napisy na stałe w obraz lub pliki filmowe nie
wymagają napisów]. Aby zapisać format na płytĊ naleĪy wybrać z górnej zakładki Project > Compile DVD
[o tym w dalszej czĊĞci instrukcji]
Dla początkujących lub testujących program bĊdzie to odpowiedni moment. Dalsza czĊĞć instrukcji
przedstawi kilka dodatkowych moĪliwoĞci programu do wykorzystania i ubarwienia naszej płyty. [Jak
wykonać zapis znajdziemy na koĔcu instrukcji]

Zaawansowane tworzenie menu [napisy, rozdziały, animacje] 
Dla wszystkich, którzy chcą bardziej urozmaicić swoją płytĊ pokaĪemy kilka przykładów i poinstruujemy jak
to zrobić.

Pierwszym punktem bĊdzie dodanie napisów do pliku filmowego. Napisy te bĊdą zamianą formatu
tekstowego na graficzny. Aktywujemy nasze Movie klikając w Connections lub Project 2x. W nowym
oknie mamy teraz moĪliwoĞć dodania napisów do naszego filmu.
Dodajemy je klikając w przycisk Sub 1 otworzy siĊ nowe okno i wczytujemy wczeĞniej przygotowane
napisy w jednym z formatów *.sub;*.srt;*.ssa;*.son;*.sst za pomocą ikony Import. Konfigurujemy
teraz poszczególne opcje: ustawiamy jĊzyk napisów przyciskiem rozwijanym i z listy zaznaczamy
odpowiedni jĊzyk. W polu Global Font and Style ustalamy wszystko co jest związane z czcionką, czyli jej
krój, wielkoĞć, wybór miĊdzy dwoma kolorami, rodzajem sposobu wyĞwietlania. MoĪemy równieĪ nieco
skoordynować marginesy, czyli opuĞcić lub podnieĞć napisy nieco na ekranie uĪywając opcji Change.
MoĪemy zaznaczyć opcjĊ Set this file always ON by default, aby ustawienia zostały zapamiĊtane jako
domyĞlne po skonfigurowaniu wszystkich elementów. Teraz odznaczamy zoom, klikamy na napis by
podejrzeć jak bĊdą wyglądały nasze napisy na ekranie. Wyszukujemy w napisach zbyt długie linie, które
mogą nie zmieĞcić siĊ na ekranie telewizora i edytujemy je. Robi siĊ to tak samo jak w edytorze tekstu,
czyli za pomocą ENTERa przenosimy do nastĊpnej linii i dzielimy zdanie, ustawiamy kursor w miejscu gdzie
chcemy podzielić tekst na dwie linie i enter. Po przejrzeniu napisów moĪemy juĪ je zacząć przepisywać do
formatu graficznego. Klikamy Generate Subtitle Stream i wskazujemy miejsce zapisu napisów z
rozszerzeniem *sp1. Po skoĔczeniu generowania program poinformuje nas komunikatem, Īe napisy
zostały dodane.
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Tworzenie Rozdziałów

Chapter > Rozdział - oznacza punkt w materiale filmowym od którego moĪe zmieniać siĊ akcja w filmie
itp. Daje nam to moĪliwoĞć przeskakiwania podczas przeglądania w odtwarzaczu [next] i szybki wybór po
wybraniu cyfry z pilota z danym rozdziałem.
Instrukcja przedstawia utworzenie własnych plików filmowych wiĊc o gotowych listach informujących o
czasach naszych rozdziałów nie ma mowy. Musimy sami wskazać miejsca gdzie bĊdą utworzone punkty z
rozdziałem. W tym celu ponownie musimy przejĞć do okna Movie. Mamy kilka moĪliwoĞci utworzenia tych
punktów, pierwszym jest wybór narzĊdzia z lewej strony okna. Łapiemy pasek poruszający siĊ po klatkach
filmowych i puszczamy w miejscu, gdzie chcemy utworzyć rozdział. Do anulowania w razie błĊdu
wybieramy drugie poniĪej narzĊdzie [Move Chapter] i klikamy w znaczek minus aby usunąć zaznaczenie.
Drugi sposób dodania to w oknie podglądu [Preview], przesuwamy suwak i miejscu wyboru klikamy na
ikonĊ Add Chapter Point. KlikniĊcie w ikonĊ zegara umoĪliwi nam podgląd czasu trwania filmu. Na
niebiesko zaznaczyliĞmy tworzenie automatycznych rozdziałów, polega to na wyszukaniu zmian oĞwietlenia
w pliku filmowym i wstawienie iloĞci rozdziałów wpisanych przez nas. Przy wyborze tego narzĊdzia pojawi
siĊ kolejne okno, w którym moĪemy właĞnie wpisać iloĞć chapterów, jakie chcemy aby program nam
utworzył.
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Teraz po utworzeniu przez nas lub program punktów z rozdziałami musimy włączyć indexowanie aby
poprawnie uruchamiały sie nasze rozdziały w filmie. W tym celu klikamy prawym przyciskiem myszy na
Movie i z menu wskazujemy Chapters > Frame-Index All Chapters. Po tym zabiegu wszystkie punkty z
rozdziałami ukaĪą siĊ w zielonych kolorach i bĊdzie moĪliwy podgląd nr klatki oraz jej czas. Oznacza to
równieĪ, Īe nasze rozdziały zostały prawidłowo utworzone. Rozdziały takie nie bĊdą oczywiĞcie widziane w
Īadnym menu a dostĊpne jedynie wyborem z pilota.

Tworzenie Menu dla rozdziałów [chapters]

Aby utworzyć rozdziały z listą do wybory trzeba zbudować nowe menu. W tym celu w connections
wybieramy ikonĊ Empty Menu [Ğrodek okna] lub pod prawym przyciskiem myszy z menu Add > Empty
Menu. MoĪna równieĪ uĪyć skrótów klawiaturowych naciskając kombinacje klawiszy CTRL+N 
Opcja pierwsza: Otwieramy nowe Menu i komponujemy listĊ podobnie jak przy wczeĞniejszym menu
wybierając narzĊdzie Aa .Do okna moĪna wstawić kolorowe tło importując jakiĞ fotos, dowolne zdjĊcie lub
zostawić po prostu czarne tło. Tworzymy napis główny w tym tle a nastĊpnie wypisujemy kolejno nazwy
naszych rozdziałów. MoĪna je oczywiĞcie ponumerować jak na przykładzie [foto poniĪej]. Po utworzeniu
listy zaczynamy dodawać odnoĞniki do kaĪdego rozdziału z osobna. Zaznaczamy rozdział i z prawej strony
w Properties > Link. Teraz moĪemy kolejno wstawiać odnoĞniki do napisów. Przykład pokazuje jak
rozdziałowi ósmemu został przypisany link do Movie 1 Chapter 8. Aby nasze napisy nie przesuwały siĊ
podczas tworzenia menu, warto zablokować ich pozycjĊ przyciskiem Lock Position w Properties/Link.

Opcja druga: To był przykład prostego menu z listą i odnoĞnikami do poszczególnych rozdziałów. Teraz
pokaĪemy jak stworzyć menu z rozdziałami wklejając do okna menu okienka z kadrem filmu. W prawej
strony klikamy na nowe narzĊdzie Insert Chapter Still i wskazujemy, który kadr rozdziału chcemy
wstawić do okna Menu. Skalujemy kadr odpowiednio by pomieĞcić kilka takich elementów. KaĪdy dodany w
ten sposób kadr bĊdzie juĪ oblinkowany. Do kaĪdego kadru moĪna wstawić podpis, którego juĪ siĊ nie
linkuje, bĊdzie stanowić tło wraz z kadrami rozdziałów.
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Opcja trzecia: Animacja. Wstawione kadry moĪemy teraz wprawić w ruch tworząc animowane menu. Aby
to zrobić klikamy prawym przyciskiem myszy na naszym tle menu i wskazujemy Render Motion. W
nowym oknie ustalamy format wyjĞciowy na MPEG 2 i wpisujemy jaki bitrate chcemy uĪyć dla obrazu
[przedział od 3500-7500 daje dobre rezultaty]. 
Total Clip Time oznacza wartoĞć w sekundach ile bĊdzie trwała nasza animacja. Intro Efect - mamy do
wyboru efekty przejĞcia, mieszanie kadrów, zachodzenie itp. Do których równieĪ przypisujemy czas trwania
[nie moĪe być dłuĪszy od całej animacji]. Zaznaczamy pierwszy rozdział i konfigurujemy ustawienia dla
niego. MoĪna zaznaczyć jak na fotograficznym przykładzie aby film powtarzał siĊ jeĞli czas bĊdzie krótki.
Zaznaczona jest animacja 15 sekundowa i jeĞli zablokujemy nasze menu [Loop] w connections, animacja
bĊdzie siĊ powtarzała. JeĞli nie zaznaczymy powtarzania dla kaĪdego rozdziału z osobna, po odtworzeniu
jednorazowym, obraz w danym kadrze zatrzyma siĊ. Warto wiĊc zwrócić uwagĊ na ten punkt i zaznaczyć
Repeat If Shorter. Dodamy jeszcze, Īe w kaĪdym rozdziale moĪna ustawić indywidualnie moment w
filmie jaki chcielibyĞmy ustawić. SłuĪy do tego pasek i ustalanie punktu startu [ Set Start Point]. Z prawej
strony w Dynamic-FX Objects, pojawić siĊ mogą napisy, które chcemy poddać animacji. Dla nich nie
ustawiamy czasów itp. 
JeĞli wszystko juĪ mamy przygotowane zapisujemy naszą animacjĊ klikając na Render. Wskazujemy
miejsce zapisu naszej animacji i czekamy w zaleĪnoĞci, od długoĞci jaką chcemy uzyskać na efekt koĔcowy.
Po skoĔczeniu renderowania naszego menu moĪemy zamknąć okno przyciskiem Close. Animacja doda siĊ
automatycznie lecz ukaĪe siĊ nam ostrzeĪenie o zastąpieniu pliku animacją. Zatwierdzamy ostrzeĪenie i po
tym punkcie nie ruszamy, nie dodajemy Īadnych nowych obiektów do naszego menu z rozdziałami.
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Po dodaniu animacji moĪemy obejrzeć na podglądzie jak wyszło zaznaczając nowe menu w connections i
uruchomić w Preview przycisk Play. Aby menu wyĞwietlało siĊ do czasu wyboru rozdziału a nie
przełączyło domyĞlnie do pierwszego rozdziału wybieramy Draw Link i przeciągamy od punktu do Ğrodka
okna tworząc Loop.
Opcja czwarta : Thumbnail Scene Selection - znana z instrukcji o miniDVD niektórym uĪytkownikom.
Rozdziały tworzą siĊ całkowicie automatycznie, my ograniczamy siĊ do wskazania rozdziałów z którego
filmu mają być wyselekcjonowane do podrzĊdnych scen menu oraz w którym Menu wstawimy
odnoĞnik/obiekt dla uruchomienia tych scen [domyĞlnie powinno to być Root i tam napis/odnoĞnik].
Powstałe okna moĪna równieĪ animować wg powyĪszego opisu.

NastĊpnym gotowym narzĊdziem jest Film Strip - wybieramy podobnie jak poprzednio.
Tworzenie takich scen nie bardzo nadaje siĊ do filmów lecz do krótkich plików np. z kamery kiedy chcemy
ładnie wyeksponować poszczególne filmiki w oknach menu z szybkim dostĊpem do nich. Skorzystanie z
tego narzĊdzia utworzy nam mnóstwo okienek ale jeĞli ktoĞ lubi moĪna utworzyć rozdziały w ten sposób.
Podobnie jak w Thumbnail wszystko odbywa siĊ automatycznie a my musimy podać w jednym z menu
odnoĞnik do pierwszego okna Page 1 . Do wyboru w programie są równieĪ trzy metody kreacji podstron.
Powstały strony równieĪ moĪemy animować.
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Rozdziały dla dwóch [lub wiĊcej] filmów: StworzyliĞmy juĪ rozdziały dla poszczególnych filmów oraz
menu do nich. Teraz trzeba to odpowiednio zaprojektować pod wzglĊdem uruchamiania w odtwarzaczu.
Przycisk jako odnoĞnik do rozdziałów moĪe być tylko jeden lub stworzymy dwa takie obiekty do
poszczególnych menu z rozdziałami i bĊdą to zwykłe podmenu. PokaĪemy jak to rozwiązać w inny sposób.
Tworzymy nowe menu [Add > New Menu]. W menu kreujemy odnoĞniki/obiekty do poszczególnych
podmenu, w których to zrobiliĞmy wczeĞniej listy do bezpoĞrednich rozdziałów plików filmowych. Z
wypełnieniem i urozmaiceniem tła juĪ nie mamy problemów. Takie powstałe Menu nazwiemy Menu 
Chapters, uĪyjmy zmiany nazwy klikając prawym przyciskiem myszy [connections] w okno powstałego
menu i wybieramy z niego Rename, wpisujemy naszą nazwĊ. Przy okazji moĪemy zmienić nazwy tych
menu z listą rozdziałów na przykład na Lista 1, 2 itp. BĊdzie bardziej przejrzyĞcie dla nas wyglądało
łączenie linkami poszczególnych okienek. 
W menu Root tworzymy jeden obiekt [np. napis: rozdziały], który bĊdzie przełączał oglądającego do
poszczególnych rozdziałów. Tak wiĊc trzeba ten powstały obiekt podlinkować do naszego  Menu Chapters.
Teraz musimy zaznaczyć w projekcie, które okno bĊdzie naszym głównym Menu dotyczącym rozdziałów.
Przechodzimy teraz do Connections i na oknie Menu Chapters klikamy prawym przyciskiem myszy a z
niego wskazujemy UOPs & Settings...W otwartym nowym oknie dotyczącym nawigacji wybieramy,
którego okna dotyczyć mają ustawienia czyli wskazujemy w menu buttons na Menu Chapters. Menu ID
ustawiamy jako Chapter Selection Menu i potwierdzamy przyciskiem OK. W oknie Menu Chapters
pojawi siĊ dodatkowa informacja o zaistniałym fakcie. W connections bĊdzie to mniej-wiĊcej wyglądało
tak:

Dodatkowe efekty dla Menu

Istnieją jeszcze dodatkowe narzĊdzia, którymi moĪemy wzbogacić nasze okna Menu w efekty.
PamiĊtajmy jednak, aby efekty te nie były tworzone po zrobieniu animacji tylko wczeĞniej.
Animacje zostawiamy zawsze na koniec.
D-FX : Przedstawimy teraz jak urozmaicić nasze obiekty/napisy w dodatkowe efekty. W tym celu
otwieramy jedno z naszych menu, np. Root. Zaznaczamy dany napis dla przykładu ten, nie stanowiący
obiektu/linka tylko bĊdący tłem informującym o zawartoĞci. Z górnego menu ikon wybieramy D-FX 
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Otworzy siĊ okno w którym wybieramy sobie dowolny efekt jaki nam siĊ spodoba do naszego projektu. Mix 
Mode ustalamy sposób wyĞwietlania a szykoĞć tworzenia efektu wybieramy suwakiem. Color Style -
ustalamy styl kolorów, dostĊpne dla niektórych efektów.

W ten sposób moĪemy dodać wraĪeĔ podczas oglądania naszego dzieła. Po zaznaczeniu efektów dla
wszystkich interesujących nas obiektów uruchamiamy Render Motion. 

Wybrana scenka z filmu w Menu? Tak, moĪna w ten sposób stworzyć ciekawe menu wklejając fragment
filmu na całe okno. Aby tego dokonać łapiemy kursorem i przenosimy fragment do okna menu a nastĊpnie
powiĊkszamy kadr do pełnego wymiaru okna. JeĞli uĪywamy przycisków lub napisów naleĪy wskazać kadr
filmu jako tło uĪywając przycisku Send To Back. W liĞcie ikon z narzĊdziami znajdziemy równieĪ inne
podobnie działające układy za pomocą których wyłaniamy, który obiekt ma pierwszeĔstwo podczas
wyĞwietlania oraz moĪemy wyrównać do siatki dany obiekt. Na koniec oczywiĞcie uruchamiamy Render 
Motion a w nim oczywiĞcie konfigurujemy czas trwania naszego klipu w menu i ustawiamy fragment filmu,
który chcemy wkleić w okno Menu. Fragment ten moĪna oczywiĞcie przygotować wczeĞniej i zaimportować
jako gotowy [pamiĊtając Īe musi być bez audio w formacie *mpv]

Efekt przejĞcia miĊdzy menu
Ostatnim efektem jaki pokaĪemy bĊdzie przejĞcie z efektem miĊdzy Menu Title a Root. W tym celu
wybieramy narzĊdzie Menu Transitions

 Teraz ustawiamy kursor na Menu Title i rysujemy przejĞcie do nastĊpnego Menu Root. 
Otworzy siĊ nowe okno konfiguracji. Wskazujemy Linki od jakiego miejsca ma siĊ zaczynać przejĞcie a na
którym koĔczyć. Rysując zaznaczyliĞmy te miejsca wiĊc odnoĞniki powinny siĊ zgadzać. PoniĪej wybieramy
jedno z wielu moĪliwych efektów w polu Transitions Type , z prawej ustalamy czasowe punkty przejĞć.
Hold A i B - oznaczają punkty zatrzymania czasowego na początku pierwszego i czas drugiego Menu. Obraz
bĊdzie zatrzymany przez efekt i po upłyniĊciu którego, moĪliwe bĊdzie odtwarzanie normalnego Menu, jeĞli
tam równieĪ wystĊpują jakieĞ efekty. Punkt pomiĊdzy Hold A i B zwany Transition oznacza czas trwania
tegoĪ przejĞcia. Tworzymy obraz przyciskiem Proceed . Proces tworzenia nie trwa długo wiĊc moĪemy
poćwiczyć i wstawić odpowiednie dla nas przejĞcie tworząc kilka próbek. Wstawione przez program
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przejĞcie usuwamy przyciskiem Delete z klawiatury zaznaczając go w Connections. MoĪemy robić
nastĊpną próbĊ.

Audio w Menu

Przygotowujemy sobie sample [krótkie fragmenty dĨwiĊkowe], które bĊdziemy chcieli umieĞcić dla danego
menu, Mogą to być fragmenty ĞcieĪki dĨwiĊkowej czy muzyki z danego filmu ale i jeĞli ktoĞ potrafi własne,
ulubione kawałki muzyczne. Dobrze jest znać obsługĊ dobrego edytora dĨwiĊku by moĪna taki fragment
sobie wyciąć i nawet ładnie wyciszyć na koniec, by dĨwiĊk nie urywał siĊ nagle podczas odtwarzania
naszego menu. Najlepiej jest teĪ importować audio w czĊstotliwoĞci próbkowania 48000 Hz by program
nam tego nie zignorował i wstawił bez problemów do menu. JeĞli ma być to fragment piosenki, najlepiej jak
animowany obraz zrobimy przynajmniej w okolicach 1 min. Dla krótszych, kilkusekundowych mogą to być
jakieĞ wstawki dĨwiĊkowe typu szum morza, czy padający deszcz. Formaty jakie obsługuje program
poznaliĞmy wczeĞniej ale najkorzystniej jest zrobić to w formacie AC3. PokaĪemy teraz jak podłoĪyć dĨwiĊk
do menu.
Fragment dĨwiĊkowy importujemy w Assets. Otwieramy okno Menu i przeciągamy zaimportowany dĨwiĊk
w pole audio. JeĞli nie widać tego pola oznacza to, Īe podgląd jest wyłączony i trzeba go aktywować
klikając na ikonĊ kadru filmu z głoĞniczkiem. Podsłuchu co prawda nie mamy w programie, ale moĪemy
być pewni, Īe dĨwiĊk na pewno pojawi siĊ podczas oglądania menu. OczywiĞcie jeĞli program wczeĞniej nie
zgłosi protestów i ostrzeĪeĔ.

 = 

Zapis
Nasz projekt jest juĪ gotowy, wiĊc teraz moĪemy przystąpić do zapisania go w struktury płyty DVD.
DVD-Lab Pro umoĪliwia równieĪ nagrywanie bezpoĞrednio po zmuxowaniu do VOBów, ale nie polecamy
uĪywać programu z powodu braku wyboru szybkoĞci wypalania. Do tego celu uĪywajmy specjalnie
zaprojektowanych programów.
Sprawdzamy dokładnie teraz czy wszystkie połączenia są prawidłowe, czy czasami jakiĞ plik nie pozostał
bez linka. Program przy zapisie bĊdzie nas jeszcze informował o błĊdach, wiĊc moĪna jeszcze wrócić i
poprawić w razie błĊdów.
Aby zapisać nasze dzieło wybieramy zakładkĊ Project i wybieramy Compile DVD. Przypisujemy w tym
oknie miejsce zapisu wskazując je przyciskiem. Tak samo postĊpujemy dla plików tymczasowych Temp. Z
prawej strony mamy graficzną informacje, ile pozostało nam wolnego miejsca na płycie. MoĪemy zaznaczyć
równieĪ redukcje Jittera i jeĞli to strandard NTSC, opcjĊ uĪycia redukcji kolorów dla niego. Naciskamy
teraz Start i czekamy cierpliwie na zakoĔczenie naszego dzieła.
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Po ukoĔczeniu tworzenia materiału na płytĊ moĪemy przed nagraniem odtworzyć i sprawdzić w playerze
czy wszystko uruchamia siĊ i działa tak, jak zakładaliĞmy.
Tak powstałe pliki Video_TS i Audio_TS nadają siĊ juĪ do nagrania płyty Video DVD.
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